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 Thank you for purchasing my E-Type EDIS Ignition Upgrade kit.  I hope it will give you many years of trouble-free motoring.  If you 

have any problems or questions, please feel free to contact me at the above e-mail or phone number.  If I am not able to answer the phone when 

you call, please leave a brief message giving the reason for your call, and your phone number, and I will get back to you as soon as I can.  In 

most cases, I will be able to return your call shortly. 

 

 Upon un-packing your kit, please compare the contents to the packing list provided, and ensure you have received all necessary parts. 

 

 Before starting your installation, please read through these instructions, and make sure you understand how everything goes together.   

 

Please note the following: 

 

1) You may find some minor discrepancies, as it sometimes appears there are no two cars exactly alike.  In particular, I’ve had a small 

number of people who’ve found various bolts to be either too long, or too short.  I’ve provided the bolts that should fit the broadest 

range of cars, but yours may be one of the outliers.  However, all the bolts are pretty common, so should not be hard to source 

locally if necessary. 

2) There are a number of variations of the kit, depending on whether you have a 3.8 or 4.2, whether your car is LHD or RHD, and 

whether you have air conditioning.  The 3.8 will always have the crankshaft pickup mounted on the LH side of the engine, next to, 

and slightly below, the water pump.  The 4.2 will usually have the crankshaft pickup mounted on the RH side of the engine, just 

above the oil pan.  Some 4.2 kits may be provided with the LH side bracket, depending on parts availability.  The 3.8 and 4.2 kits 

also use different trigger wheels and spacers. LHD and RHD kits are the same, except the RHD kit has a longer wiring harness and 

vacuum hose, and a different firewall blanking plate and spacer, so the harness and vacuum hose can enter the passenger 

compartment through the LH footwell, rather than the RH footwell.  All other parts are identical for all models. 

 



What You Need To Provide 
 

1. Standard mechanics hand tools, including sockets and wrenches, screwdrivers, Allen wrenches and feeler gauges 

2. Blue Loctite 

3. Contact cement, for re-installing the passenger-side under-dash Hardura piece 

 

Installation seems to take a full day for most people.  It is assumed that the person doing the installation is familiar with the basic 

construction of the car, and how to do the bulk of the necessary disassembly and re-assembly.  The basic steps are: 

 

1. Remove under-dash Hardura, and appropriate firewall blanking plate 

2. Remove air cleaner plenum and filter canister 

3. Remove distributor, ignition coil, ballast resistor (if any), and spark plug wires 

4. Install crank-mounted trigger wheel and VR pickup 

5. Adjust VR pickup “timing” and air-gap 

6. Install EDIS triple coilpack in distributor hole 

7. Install EDIS module to RH lower frame rail 

8. Install EDIS wiring harness and manifold  vacuum pick-off, including firewall pass-thru 

9. Install MegaJolt module on bulkhead forward of glovebox 

10. Re-install air cleaner canister 

11. Enjoy many years of trouble-free driving! 

 

A few of you may notice some slight rust present on some of the exposed parts of the steel core of the coilpack.  This is of no 

importance functionally.  I have done my best to clean these up cosmetically, but the bare steel will rust some over time.  Fortunately, once 

installed, this will not be at all visible.  Feel free to apply paint if you must, but note that the coilpack is grounded through the four corners of 

the bracket, so you must NOT paint the areas around the mounting bolts, either on the top or the bottom! 

 



Before You Start, READ THIS! 
 

1. If your car has a positive ground electrical system, it MUST be converted to negative ground before installing the kit!  Failure to do 

so WILL destroy the EDIS module and MegaJolt module.  Instructions for doing this can be found here: 

http://www.jcna.com/library/tech/tech0023.html.  This is a simple, reversible modification that typically takes just a few minutes to 

make. 

 

2. This manual describes installation for all models,  Where there are differences, you will be instructed to skip some instructions. 

 

3. The use of Blue Loctite (#242) is strongly recommended on all fasteners.  This will ensure they never come loose, while allowing 

them to remain easy to disassemble when necessary. 

 

4. Throughout this document, photos from different installations are used to illustrate how to install the various components of the kit.  

So, you will find, in places, your kit does not look exactly like the photos.  Minor details, like wire colors, have changed over time, 

so the photos may not exactly represent the current colors.  In all cases, however, the installation process should be essentially 

identical.  In particular, there are two different trigger wheels (7” and 6”), and three different crankshaft pickup brackets (3.8L and 

some 4.2L, 4.2L only, and 4.2L w/A/C).  So, study the photos in the packing list to ensure you understand what you have.  There are 

currently no photos of a RHD installation, but the only real difference between LHD and RHD kits is the firewall pass-thru, and the 

length, and routing, of the wiring harness and vacuum hose. 

 

 



Installation Step 1 - Disassembly 
 

1. Disconnect your battery! 

 

2. Remove the black hardboard panel and the glued-in Hardura from the top of the passenger side footwell. 

 

3. Open the center instrument panel, to gain access to the fuse holders. 

 

4. On the passenger side firewall, remove the firewall blanking cover that is roughly the same shape as the cover provided with your 

kit.  It is held in place by nuts accessible from the passenger footwell. 

 

5. Remove the air cleaner plenum and filter canister. 

 

6. Remove the spark plug wires, and any plug wire guides or retainers. 

 

7. Removing the spark plugs, while not technically necessary, will greatly ease rotating the engine, which is required for properly 

aligning the crankshaft trigger wheel and pickup. 

 

8. Remove the ignition coil, mounting bracket, and ballast resistor (if any). 

 

9. Remove the distributor by removing the bolt that fastens the stamped steel clamp ring to the engine block, then pulling the entire 

distributor assembly completely out. 

 

10. Slightly loosen, but do not remove, the four bolts fastening the crankshaft pulley to the damper.  The idea here is to get the bolts 

loose enough that they can be later removed without changing the crankshaft position.  There will typically be a stamped-steel 

retainer plate under at least two of these bolts that will need to be bent out of the way before the bolts can be removed. 

 

11. Rotate the engine until the timing pointer is exactly lined up with the TDC mark on the damper.  

 

 

 

 

 

 

 



Installation Step 2 –Pickup Bracket Installation 
 

12. Locate the pickup bracket assembly. 

 

13. Remove the two small button-head Allen screws fastening the black 

plastic pickup to the top of the pickup bracket, and remove the pickup 

from the bracket.  There is a boss on one “foot” of the pickup that fits 

into a counter-bore on the bracket.  

 

14. Remove the larger Allen bolt in the top center of the pickup bracket 

(see photo), and remove the upper portion of the bracket. 

 

15. If your kit includes the LHS pickup bracket (all 3.8Ls, some 4.2Ls), 

skip to step 19. 

 

16. Look at the right-front side of the timing cover, starting at the bottom.  

You will see the bolts that fasten the timing cover to the front of the block.  The bottom two are 3/8” bolts.  The pickup bracket 

mounts to the two bottom-most bolts.  The upper one is shared by the jockey pulley bracket.  Remove those two bolts.   

 

17. Apply Blue Loctite to the two Allen head mounting bolts in the lower pickup bracket, and fasten the pickup bracket to the timing 

cover, ensuring that the longer “foot” on the bracket is on the lower bolt.  Tighten the two bolts securely. 

 

18. Skip to step 21. 

 

19. Look at the left-front side of the timing cover, starting at the bottom.  You will see the bolts that fasten the timing cover to the front 

of the block.  The bottom two are 3/8” bolts, while the third is a 5/16” bolt.  The pickup bracket mounts to the upper 3/8” bolt, and 

the 5/16” bolt.    Remove those two bolts.   

 

20. Apply Blue Loctite to the two Allen head mounting bolts in the lower pickup bracket, and fasten the pickup bracket to the timing 

cover, ensuring that the longer “foot” on the bracket is on the upper bolt.  Tighten the two bolts securely. 

 

21. Re-install the upper pickup bracket on the lower bracket, sliding the upper bracket as far away from the crankshaft as it will go.  

Tighten the Allen bolt just enough to keep the upper bracket from moving on its own, but loose enough you can move it with your 

hand. 

 

 

 



Installation Step 3 – Trigger Wheel Installation 
 

22. Re-install the pickup to the pickup bracket.  It is not necessary to fully 

tighten the pickup mounting screws, as you will likely be removing 

the pickup several times in the process of setting the pickup air gap. 

 

23. Locate the trigger wheel, trigger wheel spacer, locking plate, and four 

trigger wheel mounting bolts, washers, and lock washers (see photo).  

Note that your parts may look slightly different from those in the 

photos. 

 

24. With the engine positioned exactly at TDC, remove the four bolts 

from the crankshaft pulley, making sure the crankshaft does not 

move.  It is not necessary to remove the pulley itself.   

 

25. If your kit includes the LHS pickup bracket (all 3.8Ls, some 4.2Ls), 

skip to step 32.  

 

26. Install the stamped steel “keeper” over the crankshaft center bolt, as shown in the photo on the right, so the slots in the “arms” 

roughly line-up with the bolt holes in the pulley.  It may be necessary to slightly bend the keeper to make the holes line up properly. 

 

27. The trigger wheel must be fastened to the crankshaft in a very specific 

orientation, to ensure correct base ignition timing for the EDIS 

module.  That position is shown in the photo to the right.  With the 

engine at TDC, the missing tooth in the trigger wheel should be at 

approximately 12 o’clock, and the pickup must be centered over the 

sixth tooth CCW from the missing tooth when viewed from the front 

of the engine.   

 

28. The trigger wheel mounting bolt holes are slotted, and allow 45 

degrees of adjustment.  By flipping the trigger wheel over, the 

adjustment is shifted to the other direction, so a full 90 degrees of 

adjustment is available.  Determine which side of the trigger wheel 

must be to the front to achieve the alignment indicated in the photo 

above, and install the four bolts, lock washers, and flat washer 

through the trigger wheel as appropriate. 

 



29. Slip the trigger wheel spacer onto the four bolts on the back side of the trigger wheel. 

 

30. Offer the trigger wheel up to the crankshaft pulley, roughly align the trigger wheel to the pickup as shown in the photo, then screw 

in the four bolts, and tighten them finger-tight, so that the trigger wheel can still be rotated without too much difficulty. 

 

31. Skip to the next section “Pickup Air-Gap Adjustment”. 

 

32. The trigger wheel must be fastened to the crankshaft in a very specific 

orientation, to ensure correct base ignition timing for the EDIS module.  

That position is shown in the photo to the right.  With the engine at 

TDC, the missing tooth in the trigger wheel should be at approximately 

4 o’clock, and the pickup must be centered over the sixth tooth CCW 

from the missing tooth when viewed from the front of the engine. 

 

33. The trigger wheel mounting bolt holes are slotted, and allow 45 degrees 

of adjustment.  By flipping the trigger wheel over, the adjustment is 

shifted to the other direction, so a full 90 degrees of adjustment is 

available.  Determine which side of the trigger wheel must be to the 

front to achieve the alignment indicated in the photo above, and install 

the four bolts, lock washers, and flat washer through the trigger wheel 

as appropriate. 

 

34. Install the trigger wheel spacer assembly to the back side of the trigger 

wheel, ensuring that the piece with the hexagonal center hole is against 

the back side of the trigger wheel.  Ensure that both pieces are oriented so that the four crankshaft pulley mounting bolts can be 

installed. 

 

35. Offer the trigger wheel up to the crankshaft pulley, ensure that the hexagonal cutout in the center of the trigger wheel spacer fits 

over the large nut on the center of the crankshaft.  Roughly align the trigger wheel to the pickup as shown in the photo above, then 

screw in the four bolts, and tighten them finger-tight, so that the trigger wheel can still be rotated without too much difficulty. 

 

 



Installation Step 4 – Pickup Air-Gap Adjustment 
 

36. Rotate the trigger wheel so the sixth tooth CCW from the missing tooth is precisely aligned with the center of the pickup.  There is 

an exposed metal “slug” in the center of the pickup, which is roughly the same width as the trigger wheel teeth.  Visually center the 

trigger wheel tooth to this “slug”, as shown in the photo on the right. 

 

37. Fully tighten the four trigger wheel mounting bolts. 

 

38. Rotate the crankshaft one full turn, while watching the gap between 

the trigger wheel teeth and the alignment tool.  Find the position 

where the gap is the smallest. 

 

39. It is now necessary to set the air gap between the pickup and the 

trigger wheel.  The goal is to get the gap as small as practical – ideally 

0.010-0.020”.  To accomplish this, you need to remove the pickup 

from the bracket by removing the two mounting screws, then loosen 

the adjusting screw under the pickup, sliding the upper bracket closer 

to, or further from, the trigger wheel, then re-tightening the adjusting 

screw, and re-mounting the pickup to check the gap again.  This is 

usually a somewhat iterative process. 

 

40. Once you believe the gap to be correctly set, rotate the crankshaft one more turn, to ensure that there is no contact between the 

trigger wheel and pickup at any position, and that the maximum gap is, ideally, never more than about 1.0mm (0.040”). 

 

41. Finally, rotate the crankshaft back to TDC, and ensure that the correct tooth of the trigger wheel is still exactly aligned with the 

center of the pickup. 

 

42. Remove one of  the crankshaft pulley bolts, apply Loctite to it, then re-install and re-tighten it. 

 

43. Repeat the preceding step for each of the remaining three crankshaft bolts. 



Installation Step 5 – Coilpack Installation 

 
44. Locate the coilpack bracket assembly (see photo), the “dizzy plug”, 

the ¼-20 x ¾” button-head Allen screw (in the Misc. Parts Bag) and 

the ¼-28 x ¾” Allen head mounting bolt. 

 

45. Remove the four Allen head bolts fastening the coilpack to the 

mounting bracket, and remove the coilpack from the bracket. 

 

46. Apply Blue Loctite to the ¼-20 x ¾” button-head Allen screw, and 

use it to attach the “dizzy plug” to the bottom side of the coilpack 

bracket. 

 

47. Apply oil or grease to the O-ring on the “dizzy stub” on the 

underside of the coilpack bracket, to ease its insertion into the 

block. 

 

48. Insert the “dizzy plug” on the underside of the coilpack bracket into 

the distributor hole in the engine block, ensuring that the hold-down bolt hole in the bracket is over the distributor clamp bolt hole in 

the block.  Push it down until it is fully seated against the block. 

 

49. Apply Blue Loctite to the ¼-28 x ¾” hold-down bolt, install the bolt, and tighten it securely. 

 

50. Put the coilpack back on the bracket, with the 4-pin connector on the side away from the engine, then re-install and securely tighten 

the four mounting bolts. 

 



Installation Step 6 – Pickup and Coilpack Wiring Harness Installation 

 
51. Locate the wiring harness. 

 

52. I suggest taking a few minutes to look at the connectors on the harness, and the mating connectors on the pickup, coilpack, EDIS 

module, and MegaJolt.  Each of these connectors has a very positive latch which MUST be properly disengaged before it will be 

possible to remove the connector from the device.  Make sure you fully understand how each connector is oriented, and how each 

latch works, as it can be extremely frustrating trying to disconnect the harness if you don’t know how to disengage the latch, and 

some, particularly the pickup connector, are not very visible once installed.  Attempting to remove a connector without properly 

disengaging the latch WILL result in damage to the connectors, and/or the wiring harness.  Such damage WILL NOT be handled as 

a warrantee repair.  It will be helpful to “break-in” the connectors by fully seating them on their mating connectors before beginning 

installation. 

 

53. Locate the EDIS connector, which is the large, gray connector.  There are two separate harnesses coming off this connector.  One 

goes forward to the coilpack and crankshaft pickup, while the other goes rearward into the passenger compartment, where the 

MegaJolt is mounted.  The pickup/coilpack end has a black rectangular, two-pin connector for the pickup, and a black, oval, 4-pin 

connector for the coilpack.  The MegaJolt end has a red female spade connector, a ring terminal, and a rectangular white plastic 12-

pin connector. 

 

54. Coil up the MegaJolt end of the harness, and lay the harness on the lower mud guard where the air cleaner sits.  Route the 

pickup/coilpack end of the harness forward along the round frame tube, inboard of the stamped steel frame stiffener next to the front 

suspension, and under the coilpack. 

 

55. Bring the coilpack connector up along the front of the coilpack, and install the connector on the coilpack, ensuring that the 

connector latch engages fully. 

 



Use a Zip-tie around one of the the coilpack “feet” to secure the 

harness to the coilpack bracket in such a way that the wires gently 

curve from the front of the coilpack back to the connector, with NO 

tension on any of the wires.  This is very important to avoid fatigue 

failure of the wires when the engine moves around.  ALL movement 

must be accommodated by the harness between where it is secured 

to the front of the coilpack and where it is (later) secured to the 

round frame tube. 

 

56. Locate the single white wire terminated in an insulated male spade 

terminal coming off the harness near the coilpack connector.  This 

wire must be connected to the White wire which was connected to 

the “+” terminal of the stock ignition coil.  This connection provides 

power to the coil when the ignition switch is turned on.  Ensure that 

you get the two spade connectors fully seated against each other. 

 

57. I suggest taping or otherwise securing both sides of the coilpack 

power wiring to the factory harness, or anything else that will provide additional support to ensure the connection cannot come 

loose.  This can be done with Zip-ties, heat shrink, electrical tape, etc.  You can see in the preceding photo how I did mine.  I used 

two zip-ties to fasten the power wire to the cars wiring harness, with one zip-tie on each side of the spade connection, so they cannot 

possibly come loose. 

 

58. If your kit includes the LH pickup bracket, skip to step 62. 

 

59. Route the pickup end of the harness alongside the coilpack end to the pickup bracket, and secure it using the insulated cable clamp 

on the pickup bracket in such a way that the wires gently curve from the harness at the insulated cable clamp to the pickup 

connector, with NO tension on the wires.  This is very important to avoid fatigue failure of the wires when the engine moves around.  

ALL movement must be accommodated by the harness behind the insulated cable clamp. 

 

 

 

 

 

 

 

 

 

 



60. Route the pickup end of the harness alongside the coilpack, to the front of the coilpack, then behind the water pump bypass hose, 

and across the front of the engine above the water pump, and over to the pickup (see photos below). 

 

61. Locate two insulated cable clamps provided with your kit.  These will be used to secure the pickup harness to the front of the 

engine.  One clamp should be installed on the upper left-hand water pump mounting bolt, and the other on the factory coil bracket 

mounting stud on the breather cover, as shown in the two photos below.  Ensure that both secure the harness so that it cannot move 

around and risk getting tangled in the fan belt, but without putting any strain on the harness.  In particular, it is very important that 

there be NO tension whatsoever on the two exposed pickup wires. 

 

 

 

62. Plug the pickup connector onto the pickup, ensure that it is fully seated, and that the latch is fully engaged. 

 

 

 

 

 



Installation Step 7 – Plug Wire Installation 

 
63. Locate the spark plug wires, the plug wire organizer, and the three plug wire clips that came with your kit.  Note that each plug wire 

is marked with a number at both ends, indicating the cylinder to which it should be connected.  Keep in mind that cylinder #1 is at 

the back of the engine, cylinder #6 at the front. 

 

64. Read through the following steps before beginning installation, and refer to the photos below for a reference on how I installed 

mine.  Several small packets of dielectric grease are provided.  This can be used to lubricate the boots on the spark plug wires, to 

make them easier to get on and off. 

 

65. Install the wires one at a time, starting at cylinder #1, routing them over the front of the intake manifold, and behind the bypass 

manifold, then down to the coilpack. 

 

66. As you install each wire, connect it to the coilpack.  The #1 wire goes to the coil terminal at the top left when viewed from the right-

hand side of the car.  Subsequent wires get connected in a clock-wise order, so that cylinder #2 is connected to the top-middle 

terminal, #3 to the top-front terminal, #4 to the lower-front, etc.  DO NOT pay attention to the label on the coilpack – The 

arrangement shown on the label applies only to a V6 engine. 

 

67. Each wire should be installed so it approaches the coilpack from the rear, at an angle, (see photo).  The exact arrangement is not 

critical, but it is advisable to keep the wires separated as much as possible, and arranged neatly. 

 

68. Be sure all wires are FULLY inserted into the coilpack terminal, each 

boot is fully seated, and each boot retainer is securely locked over the 

ridge on its terminal tower. 

 

69. After all wires are installed, remove the four cam cover acorn nuts 

just behind the wider front portion of the timing cover, to enable 

installation of the plug wire organizer. 

 

70. Disassemble the plug wire organizer by pulling off the metal end 

caps, then removing the two Philips head screws from the insulator.  

Place the two halves of the insulator bar around the plug wires as they 

pass over the valve cover, the slip the end caps back on.  Finally, re-

install the two Philips head screws, being careful not to over-tighten 

them.  They should be little more than finger-tight. 

 

71. Drop the organizer over the four cam cover studs, and re-install the 



acorn nuts.  You will have to use an open-end wrench to tighten the nuts.  Do not over-tighten them! 

 

72. Push/pull the wires through the organizer to get them arranged neatly 

over the valve cover, and down the engine valley (See photo). 

 

73. Finally, install the three plastic plug wire clips as necessary to keep 

the wires neatly arranged in the engine valley (see photos). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Installation Step 8 – Vacuum Line Installation 

 
74. Locate the vacuum hose that runs from the rear of the intake manifold 

to the vacuum reservoir.   

 

75. Remove this hose from the vacuum reservoir. 

 

76. Locate the vacuum “tee”, two hose clamps, and small vacuum hose 

provided with your kit. 

 

77. Cut your vacuum hose 2-3 inches from the end, and install the “tee” 

where you cut the hose, securing both connections with the provided 

clamps.  Install the small vacuum hose on the small fitting of the 

“tee”. 

 

78. Re-connect the vacuum hose, and it’s new “tee” fitting, to the 

reservoir (see photo). 

 

79. Route the vacuum hose over towards the passenger footwell area of the firewall.  For RHD installations, route the hose behind the 

engine, and secure it (and the wiring harness) to the firewall using some of the provided ZipTies. 

 



Installation Step 9 – EDIS Module and Wiring Harness Installation 

 
80. Locate the EDIS module, its mounting bracket and the two ¼-20 x 

2” Allen screws from the Misc. Parts Bag. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

81. Install the wiring harness on the EDIS module, ensuring that the 

connector is firmly seated on the EDIS module, and the latch is 

fully engaged.  There is a very good weather seal on these 

connectors, so it can take a fair amount of force to get them fully 

seated.   

 

82. Apply Blue Loctite to the two mounting bolts. 

 

83. Hold the bracket under the lower RH frame rail, just behind the 

mud shield (see photo), set the EDIS module on top of the frame 

rail and install the two mounting bolts (see photo).  Do not over-

tighten these bolts!  They do not need to be terribly tight, and 

over-tightening them can break the EDIS module. 

 

84. Route the rear harness extension (the long end, terminated in two 

Red wires and a spade connector) along the round frame tube, to 

the passenger side firewall, and through the pass-thru cutout in the firewall, fastening it along the way with Zip ties.  Place at least 

one Zip Tie directly above the EDIS module, and nsure that there is NO tension on the wires to the EDIS module connector! 



 

85. Note that in the following steps, only the LHD firewall pass-thru is 

shown, but installation for the RHD pass-thru is basically identical, 

except for the pass-thru being a different size and shape, and being 

located on the opposite side of the car. 

 

86. Locate the firewall blanking cover assembly provided with your kit 

and look at the front face.  Note the two holes in the end of the plastic 

spacer.  These are for the wiring harness and vacuum hose to pass-

through into the passenger compartment.  Note that one hole is 

slightly larger than the other.  The larger hole is for the wiring 

harness, while the smaller one is for the vacuum hose. 

  

87. Remove the flange nuts from the blanking cover assembly, and 

remove the screws, then separate the lower of the two plastic spacers 

enough to be able to get the wiring harness through between the two 

spacers. 

 

88. Pass the end of the wiring harness, including the white MegaJolt 

connector, through the larger hole in the spacer, and pass the vacuum 

hose through the smaller hole.  Return the lower spacer to its position 

against the upper spacer.  Position the spacer assembly over the cutout 

in the firewall, position the harness and hose in the approximately 

appropriate position with respect to the spacer, then install the flange 

nuts on the mounting screws in the passenger-side footwell.  Once 

you’ve ensured the harness and hose are correctly positioned, tighten 

the nuts securely. 

 

89. Route the long end of the harness, with the ring connector and female 

spade connector, into the center fuse panel area.   

 



90. Secure the ring terminal on the ground lead to the screw that secures 

the RH angle bracket to the dashtop as shown in the photo on the 

right. 

 

 

 

 

 

 

 

 

 

 

 

 

 

91. The harness B+ feed (white wires with pink spade connector) needs to 

be connected to a switched +12V source.  I recommend using the fuel 

pump fuse, but any switched circuit can be used.  On 3.8L and early 

4.2L cars, the fuel pump should be on fuse 4 (as shown in the photo 

on the right).  On later cars, it should be on fuse 6.  However, there 

appears to be significant variation from car-to-car, so I suggest 

double-checking the terminal you select is switched. 

 
 

 

 

 

 

 

 

 

 

 

 

 



92. Route the vacuum hose and MegaJolt harness toward the right side of the glove box, securing them in the existing firewall harness 

“clips” where possible. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Installation Step 10 – MegaJolt Module Installation 

 
93. Look at the bulkhead behind, and to the right of the glovebox.  Note 

the two 5/16-24 threaded holes in the (circled in red in the photo).  

These will be used to mount the MegaJolt, using the two special 

stand-offs provided in your kit (see photo). 

 

The stand-offs thread into the holes in the bulkhead, and the mounting 

flanges on the MegaJolt fit into the grooves under the heads of the 

stand-offs. 

 



 

 

94. Screw one of the stand-offs into the upper hole in the bulkhead.  Be 

careful not to over-tighten it!  The stand-offs are aluminum, and are 

easily stripped.  They really do not need to be more than finger tight. 

 

95. Connect the MegaJolt to the wiring harness, with the harness leaving 

the MegaJolt to the left, then slip the cutout in the upper mounting 

flange of the MegaJolt into the slot in the stand-off. 

 

96. Slip the other stand-off into the cutout in the lower mounting flange 

of the MegaJolt, then carefully screw it into the lower hole. 

 

97. Trim the vacuum hose to length, and attach it to the fitting on the 

right-hand side of the MegaJolt. 

 

 

 

Installation Step 11 – Fire in the Hole! 

 
98. At this point, you should be ready to run!  Re-connect the battery, and try to start the engine.  If all is well, it should fire right up 

easily, and run smoothly.  If it does not, proceed to the Debugging section for suggestions on how to isolate the problem. 

 



Changing/Modifying Advance Curves 

 
Your MegaJolt should have come pre-programmed correctly for your car.  However, there is considerable difference from car to car, so 

some minor adjustment of the advance curves may be desirable.  I will not even attempt to give a primer on the many factors involved in doing 

this correctly, but will give a quick run-down of the steps involved in actually effecting the changes.  For details on the hows and whys of 

MegaJolt and EDIS, refer to the following website: 

 

http://www.autosportlabs.com/megajolte-p-41.html 

 

First, you will need a laptop computer with a serial port.  This is a 9-pin D-Sub connector, that looks like this: 

 

 
 

If your computer does not have this connector, then you must have an available USB port, which looks like this: 

 

 
 

Any computer built in the last 10 years or so should have several USB connectors.  You will also have to purchase a USB-to-serial 

adaptor cable.  I recommend this one, as it is proven compatible with the MegaJolt: 



 

http://www.autosportlabs.com/compact-usbserial-adapter-p-57.html 

 

Connect the MegaJolt to your computer using the supplied modular cable and modular-to-9-pin adaptor.  The modular cable plugs into 

the right-hand side of the MegaJolt next to the vacuum hose. 

 

The latest version of the Configuration/Tuning software can be downloaded for free from here: 

 

http://www.autosportlabs.net/MJLJ_V4_Downloads 

 

Once the cable is in place, the software downloaded and installed, you are ready to go.  Turn on the ignition, but don’t start the engine.  

Start the Configuration and tuning software, and click on the “Get Ignition Configuration” toolbar button, as indicated in the following photo.  

This will read the advance configuration from the MegaJolt, into your computer, and display it as shown in the photo (your display may be 

slightly different). 

 

First thing you want to do the first time you program your MegaJolt, is ensure it is properly configured.  Click on the “Tools” Menu, 

select “Global Controller Options”, and make sure your settings match these: 

 

 
 

 



 If you do not see the same settings as above, use the arrows on the right of the textboxes to set them to the same values shown above, 

the click the “Write options” button to write them to the MegaJolt.  If the number of cylinders is not set correctly, the timing WILL NOT be 

correct!  The cranking advance option sets the timing used when the engine is being cranked.  In some cases, changing this may give you 

slightly better starting performance. 

 

 The commands you will use the most are the ones outlined in red in this picture: 

 

 
 

 The left-most of these three buttons, “Get Ignition Configuration”, will read the current configuration stored in your MegaJolt, and 

display it on the PC.  The middle button, “Write Ignition Configuration”, will transfer the configuration currently displayed on the PC to the 

MegaJolt RAM.  This will allow you to test a new configuration, but this configuration will be lost as soon as the MegaJolt is powered down 

by turning off the igntion.  The right-most button, “Commit Configuration To Flash”, programs the configuration stored in the MegaJolts RAM 

into its FLASH memory, so it will become the default configuration for your MegaJolt, even after it is powered off. 

 

 In general, any time you make a change, you will want to click first on “Write Ignition Configuration”, followed by “Commit 

Configuration To Flash”.  Make sure you ALWAYS save a copy of your old configuration using File->SaveAs, in case you need to go back to 

it. 

 

The two default maps provided with the EDIS kit are close approximations of the factory advance curves for the 3.8L and S1 4.2L E-

type.  These are in the files “S1 4.2LVacuumStock.mjlj” and “S1 4.2LVacuumStock.mjlj”.  Either of these is likely to work reasonably well on 

any E-type.  I would suggest trying them both, and seeing how then work on your engine.  To use either of these, use File->Open to select the 

file, then use “Write Ignition Configuration” followed by “Commit Configuration To Flash” to program it into the MegaJolt. 

 



The great thing about the EDIS/MegaJolt system is it lets you customize the advance curves to best suit your particular engine.  This has 

a number of very practical applications.  For example, my 3.8L, with a completely stock advance curve, is prone to light pinging between 1800-

2500 RPM.  The MegaJolt allowed me to back off the timing advance a few degrees, just during this range, to completely eliminate this 

problem.  This would have been impossible to do with a mechanical distributor.  I also found my idle quality is improved with more advance.  

In fact, with 20 degrees advance, it idles very smoothly.  I programmed this advance only under 1000 RPM, and only under minimum load.  

Again, with a mechanical distributor, this would be impossible. 

 

If you have a trouble-spot, like my pinging problem above, you can figure out exactly where it is in the advance map by having your 

computer hooked up to the MegaJolt as you drive.  It will show you which cell in the advance map is active at all times, so you know exactly 

where to make a change. 

 

I would be careful about making major changes, however.  Too much advance, or too little, under the proper conditions, can be very 

damaging to an engine.  But small changes, a few degrees here or there, should be harmless. 

 



Debugging 
 

There is actually very little that CAN go wrong in the EDIS installation.  By far the most common problem will probably be incorrect 

setup of the crankshaft pickup and trigger wheel.  If you don’t think the system is working properly, do the following: 

 

1) Make sure the power connections behind the instrument panel are getting good power when the ignition switch is turned on 

2) Make sure the ground connection have a solid connection to the body of the car.  Remove the paint under the connection if 

necessary. 

3) Make sure that the coilpack is receiving power from the White wire in the factory harness that used to go to the ignition coil. 

4) Double check that all connectors are fully seated and latched in place – crank pickup connector, coilpack connector, coilpack B+ 

wire, EDIS module connector, MegaJolt connector, and both power wires. 

5) Double check the spark plug wires are all properly connected to the coilpack. 

6) If all of the above checks out but you still can’t get the engine to start or run properly, disconnect the white connector from the 

MegaJolt, and try to start the engine.  If it does not start, check to see if you’re getting a spark to any of the plug wires.  A lack of 

spark almost has to be a problem with the wiring, or a failed EDIS module. 

7) If the engine starts with the MegaJolt disconnected, use a timing light to verify that the timing is 10BTDC.  If it is not, then you 

have not properly mounted the trigger wheel and pickup. 

8) If the engine starts with the MegaJolt disconnected, but does not start or run well with the MegaJolt connected, then either the 

MegaJolt is improperly configured, or defective.  I suggest downloading the free configuration tool, and verifying, or re-

programming, the configuration. 

9) If all of the above fails to resolve your problem, please feel free to contact me. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


